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Licensing, registration and evaluation information

SPLOT is distributed as "Shareware" or "User Supported Software" and is fully copyrighted. 
If you register the program you will receive these benefits:

1) The latest version of SPLOT.
2) A printed user's manual.
3) A printed technical reference which describes all plotter instructions supported by 
SPLOT.
4) An end to the nag screens and opening banners.
5) Deep discounts on the next major versions.

The single user registration fee for SPLOT for Windows is $65.00 (US funds). The 
multisystem site fee for SPLOT is $140.00. Users outside of Europe should include an 
additional $5.00 for international airmail.

Author can accept payment in these three ways:

1) In cash (money enclosed)    -    this is the most quick method, but at your risk.
2) Credit card    -    MasterCard, VISA and American Express are accepted. Please, fill 
out carefully the credit card information in the Registration / Order Form.
3) Bank or travelers cheque enclosed    -    please make a cheque payable in US funds.

Since the SPLOT program is always distributed with a DLL library (libraries) adapted for a 
certain plotter type, do not forget to mention the plotter type with which you want to use the
SPLOTprogram. A list of plotters you can choose from is given in the PLOTTERS.TXT file. In 
this file there are also given the parameters of these plotters together with a list of 
supported instructions. It makes possible to choose a suitable plotter type even if your 
plotter is not listed (most plotters are compatible with some plotter from the list). Of course, 
you can order SPLOT program with more DLL libraries for different plotter types. In this case 
the single user registration fee for any further DLL library is $20.00 (+ $5.00 outside Europe)
and the multisystem site fee is $40.00 (+ $5.00 outside Europe). This principle is also valid 
for an upgrade. If you have registered at least one SPLOT program version at the full price of
$65.00 ($140.00), now and in the future only $20.00 ($40.00) is to be paid for all other 
versions.

Special offer: 
Registered users of the MS-DOS version of the SPLOT program can order the MS-Windows 
version for $45.00 only ($95.00 for the multisystem site licence) (+ $5.00 outside Europe). 
In this case fill out your serial number in order form and mark it as 'upgrade from DOS 
version'.
Note: The latest MS-DOS version of the SPLOT program is available on all SIMTEL20 archives 
in <MSDOS.GRAPHICS> directory as SPLTXXX.ZIP file (recently SPLT251.ZIP).

To register, please use the Registration / Order Form supplied with this package (also 
provided in the file ORDER.TXT). Please send the completed form along with a payment to:

Alexandr Novy
Havlickova 2209
390 01 TABOR
Czech Republic

NOTE: Czech users of SPLOT should contact a Czech distributor:



PESKA & BRTNA Computer Service
Krakovska 2805
390 05 Tabor
Czech Republic
Tel./Fax    0042-361-42138

or
SOFTECH
P.O.B. 69
323 00 Plzen 23
Czech Republic
Tel./Fax    0042-19-226294

A special Czech language version of the package is available from them as well.

EVALUATION AGREEMENT

SPLOT is not and has never been public domain software, nor is it free software.

Non-licensed users are granted a limited license to use SPLOT on a 14-day trial basis for the 
purpose of determining whether SPLOT is suitable for their needs. The use of SPLOT, except 
for the initial 14-day trial, requires registration. The use of unlicensed copies of SPLOT by 
any person,business, corporation or any other entity is strictly prohibited.

No one may modify or patch the SPLOT executable file in any way, including but not limited 
to decompiling, disassembling, or otherwise reverse engineering the program.

A limited license is granted to copy and distribute SPLOT only for the trial use of others, 
subject to the above limitations, and also the following:

1) SPLOT must be copied in unmodified form, complete with the file containing this 
license information.
2) The full machine-readable SPLOT documentation must be included with each copy.
3) SPLOT may not be distributed in conjunction with any other product without a specific 
license to do so from author.
4) No fee, charge, or other compensation may be requested or accepted, except as 
authorized below:

a) Operators of electronic bulletin board systems (sysops) may make SPLOT available 
for downloading as long as the above conditions are met. An overall or time-dependent
charge for the use of the bulletin board system is permitted as long as there is not a 
specific charge for the download of SPLOT.
b) Vendors of user-supported or shareware software may distribute SPLOT after 
obtaining written permission from author. Such permission is usually granted. Vendors 
may charge a reasonable disk duplication and handling fee.

LICENSING AGREEMENT

Licensed user are bound to the following licensing agreement.

You may not transfer your license without written permission from author. A single user 
license permits a user to use SPLOT only on a single computer at a time.

This product is distributed AS IS. The author specifically disclaims all warranties, expressed 
or implied, including, but not limited to, implied warranties of merchantability and fitness for 



a particular purpose with respect to defects in the diskette and documentation, and program
license granted herein, in particular, without limiting operation of the program license with 
respect to any use or purpose.    In no event shall the author be liable for any loss of profit or 
damage including but not limited to special, incidental, consequential or other damages.

By licensing SPLOT you agree to the above licensing agreement.



How to register

 To register, study Licensing, registration and evaluation information and send completed 
Registration / Order Form (also provided in the file ORDER.TXT) along with payment to:

Alexandr Novy
Havlickova 2209
390 01 TABOR
Czech Republic

If you experience any problems, please let me know.

E-mail:
Bitnet:            novy@csearn
Internet:      novy@earn.cvut.cz



Order Form for SPLOT - The Pen Plotter Simulator for Windows
                                              Select "File-Print Topic" from the menu bar to print this form.

 Your Name:__________________________________________________________

 Company: ___________________________________________________________

 Address: ____________________________________________________________

              City: _____________________________    Prov/State:______________________

 Country: _____________________________    ZIP/Postal:______________________

 If you are registered user already, your serial number: ________________

    Licence: [      ]      single user           [      ]    multisystem site

    Disk:          [      ]      5 1/4 inch           [      ]    3 1/2 inch

    Payment: [      ]    Cash (money enclosed)
                                  [      ]    Credit card (fill out credit card information below)
                                  [      ]    Bank or travelers cheque (payable in US funds)

    I'd like to order the SPLOT program for the following plotter type(s):

    [      ] HP 7470A ........................................................................ ____________ US$

    [      ] HP 7475A ........................................................................ ____________ US$

    [      ] HP 7440A ColorPro .................................................. ____________ US$

    [      ] HP 7550A ........................................................................ ____________ US$

    [      ] HP DraftPro .................................................................... ____________ US$

    [      ] HP DraftMaster ............................................................ ____________ US$

    [      ] Roland DXY .................................................................... ____________ US$

    [      ] Roland GRX 300/400      ............................................ ____________ US$

    Shipping (Outside Europe)    ........................................... ____________ US$

    TOTAL AMOUNT .................................................................. ____________ US$

    I hereby authorize the above amount to be charged to my

          [      ] MasterCard                    [      ] VISA                    [      ] American Express

    Name as it appears on card:____________________________________________

    Credit card number:___________________________ Expiration date:___________

    Signature:___________________________________

 Your comments: ________________________________________________________

______________________________________________________________________

______________________________________________________________________
                                                          (add any additional comments you wish separately)

Mail this form to:          Alexandr Novy
                                                            Havlickova 2209



                                                            390 01 TABOR
                                                            Czech Republic



Introduction

    The SPLOT program is a highly effective tool intended for simulating the pen plotter on the
display of an IBM PC.    The SPLOT program is the very thing you need to make your work 
with the plotter more effective. The SPLOT program will give you a guarantee you will always
draw on your plotter what you really want. That is why it will save your nerves, your time, 
your plotter, pens and paper, that means your money.

The SPLOT program can offer:
- active support of about 50 HP-GL instructions (according to the type of simulated 
plotter).
- active support of 20 DXY-GL instructions (for ROLAND plotters).
- possibility of exporting a    picture to the printer and    in this way to obtain an output of a
high quality. In this way the SPLOT program will make a fast and excellent plotter of your 
printer.
- exporting a picture to the HP-GL, DXY-GL and DXF formats.- possibility of making picture 
cuts (the ZOOM function). In this way you can scan, draw on the plotter or    print only the 
selected part of the picture.
- to teach your plotter the advanced instructions you would get only if you buy a more 
expensive plotter or additional hardware    (e.g., the SPLOT program can simulate 
connecting an additional HP 17440A graphics enhancement cartridge to the HP 7440A 
ColorPro plotter).
- possibility of processing a HP-GL text including multilingual characters - in this way the 
SPLOT program will teach your plotter German (Spanish, French, etc.) easily and quickly 
without complicated switching between character sets!

The SPLOT program can be used by:
- anybody who wants to work with his plotter in the WYSIWYG style (What You See Is What
You Get).
- anybody who wants to develop his own plotter program applications. You can reach it 
with the SPLOT program easily even if you do not own the plotter at all!
- anybody who wants to use his printer as a plotter occasionally or constantly. In many 
cases using a printer may be faster and moreover, this may be an alternative of a high 
quality.
- anybody who wants to program a printer in graphics mode and at a high level and who 
does not want to develop complicated software which would enable it. In these cases 
using the HP-GL language in connection with the SPLOT program seems to be very 
advantageous for creating own graphics outputs. The HP-GL language can be learned 
very easily and in addition, it offers unexpected possibilities.

    The SPLOT program is available for various plotter versions. This means that there are 
provided DLL modules designated for a certain plotter type. This principle gives the 
maximum reliability of simulation of the given plotter type. At present the DLL modules for 
the following plotter types are at your disposal:

(Plotter type    /    Plotter syntax      /    Module name)
- HP 7470A      /      HP-GL      /      HP7470.DLL
- HP 7475A      /      HP-GL      /      HP7475.DLL
- HP 7440A ColorPro      /      HP-GL      /      HP7440.DLL
- HP 7550A      /      HP-GL      /    HP7550.DLL
- HP 7570A/7575A/7576A DraftPro DXL/EXL      /      HP-GL      /      HP7570.DLL
- HP 7595A/7596A DraftMaster I/II      /      HP-GL      /      HP7595.DLL
- ROLAND DXY 1100/1200/1300      /      DXY-GL / RD-GL I      /    ROLDXY.DLL
- ROLAND GRX 300/400      /      RD-GL II      /    ROLGRX.DLL

An UNREGISTERED COPY of the program is available only in the version for the HP 7475A 



and for the HP DraftMaster plotters. The versions for other plotter types can be received only
on the basis of a regular registration. See the Licensing, registration and evaluation 
information.



SPLOT Working Principles

    The plotter simulation consists in interpreting plotter instructions contained in a disk file. 
The SPLOT program reads these instructions from the file and plots them on the screen of 
the computer in the same way as the plotter would do on paper. The file is plotted in the 
window (drawing area) which represents the plotting paper of the plotter. The boundaries of 
this drawing area normally correspond to the hard clip limits of the plotter (i. e., to the 
physical limits in which a plotter pen can move for the selected paper size). If the ZOOM 
function is used, only the chosen plotting area is displayed in this drawing area.

    In the Microsoft Windows environment the size of the drawing area can differ from the size 
of the client area. If any dimension of the client area is larger than those of the drawing 
area, the superfluous area of the client area is gray colored. The color of the drawing area 
(paper) is always white. If any dimension of the client area is smaller than those of the 
drawing area, one or two scroll bars appear on the edge of the client area, which allow you 
to scroll through the contents of the drawing area. Use the Resize menu command to cause 
the equality of the client and drawing areas. This equality is maintained automatically if the 
Dynamically Resize item in the Options menu is checked. If the Proportional Aspect Ratio 
item in the Options menu is checked, the aspect ratio of the drawing area is maintained to 
be identical to the aspect ratio of the selected paper size (see the Paper Size dialog). 
Otherwise there can be any aspect ratio of the drawing area which can lead to the 
deformation of the image.



Command Line Parameters

The SPLOT command line (as it can be used in the Program Manager's Program Item 
Properties) has the following syntax (items inside square brackets are optional):

SPLOTW.EXE      [/device_name]      [startup_directory_name]      [plot_filename]

where:

SPLOTW.EXE    is the SPLOT executable file name,

and the optional parameters are:

device_name
is the name of the plotter device which will be simulated after program startup. It must be
preceded by slash. The following names are allowed:

HP7470A    for the HP7470A plotter (requires HP7470.DLL library),
HP7475A    for the HP7475A plotter (requires HP7475.DLL library),
HP7440A    for the HP7440A ColorPro plotter (requires HP7440.DLL library),
HP7550A    for the HP7550A plotter (requires HP7550.DLL library),
HP7570A    for the HP7570A DraftPro plotter (requires HP7570.DLL library),
HP7575A    for the HP7575A DraftPro DXL plotter (requires HP7570.DLL library),
HP7576A    for the HP7576A DraftPro EXL plotter (requires HP7570.DLL library),
HP7595A    for the HP7595A DraftMaster I plotter (requires HP7595.DLL library),
HP7596A    for the HP7596A DraftMaster II plotter (requires HP7595.DLL library),
RDXY1100    for the ROLAND DXY 1100 plotter (requires ROLDXY.DLL library),
RDXY1200    for the ROLAND DXY 1200 plotter (requires ROLDXY.DLL library),
RDXY1300    for the ROLAND DXY 1300 plotter (requires ROLDXY.DLL library).
RGRX300    for the ROLAND GRX 300 plotter (requires ROLGRX.DLL library),
RGRX400    for the ROLAND GRX 400 plotter (requires ROLGRX.DLL library),

Example:        
The command line
          SPLOTW.EXE      /HP7595A
starts the SPLOT program with simulating of the HP7595A DraftMaster I plotter.

If you don't use this command line parameter, the SPLOT program uses a default device 
name which depends on plotter type for which you ordered the SPLOT program. If you 
ordered SPLOT program for more than one plotter type you will receive more SPLOT 
executable files (which will vary by the default startup plotter type) along with 
corresponding DLL libraries. However, you can copy to your disk only one SPLOTW.EXE 
instance with all needed plotter DLL libraries. Then you can create more SPLOT program 
items in Program Manager which will vary by the device_name command line parameter.

After program startup you can change simulated plotter type through the Plotter Type 
Menu.

startup_directory_name
is the name for the current working directory immediately after the program startup. You 
can set this directory name in the Program Manager's Program Item Properties too. The 
setting of the startup directory is important because the SPLOT program searches for the 
Configuration Files first in this directory.



plot_filename
is the name of the file which will be plotted immediately after program startup (if it 
exists).



Zooming

With the mouse cursor you can make and enlarge the chosen cuts of the plotted image. By 
pressing the left mouse button in the drawing area you define first corner of the zooming 
box. The next mouse movement expands and contracts the zooming box around the area 
you desire to enlarge. The colors of the zooming box area are inverted. If you press the right 
mouse button with the left mouse button simultaneously or the Shift key is pressed, the box
moves as a whole. Until you have the left or right mouse button depressed, you are in the 
zooming box definition mode in which you define the size and position of the zooming box. 
As soon as the zooming box of any size is defined you can use the Zoom menu command to 
start zooming. If you have a three button mouse with appropriate mouse driver installed, 
you can use the middle button to start zooming too. The zooming starts automatically if the 
Dynamically Zoom item in the Options menu is checked. 

The zooming is performed so that the selected zooming box is enlarged to the entire 
drawing area (note that the size of the screen drawing area is changed only through the 
Resize menu command or automatically with the change of the size of the client area if the 
Dynamically Resize item in the Options menu is checked). If the Proportional Aspect Ratio 
item in the Options menu is checked, the aspect ratio of the displayed cut is identical to the 
aspect ratio of the selected paper size (see the Paper Size dialog), regardless of the aspect 
ratio of the selected cut. To ensure proportional aspect ratio of the displayed cut the size of 
the displayed cut area is usually larger than the size of the selected cut area. If the 
Proportional Aspect Ratio item in the Options menu is not checked, the selected cut area is 
always identical to the displayed cut area and is fitted to the entire drawing area. This 
usually leads to the deformation of the displayed image.

To expand the picture into the original size press the Tab key or    use the Expand menu 
command or press the middle mouse button if you have any.

You can change the size and position of the already defined zooming box if the Dynamically 
Zoom menu item is not checked,. To do this press the right mouse button in the drawing 
area. Then you can change the position of the zooming box. To change the size of the 
zooming box press simultaneously the left button and then release right button.

Another purpose of the zooming box is to select a part of the picture for printing or exporting
(see the Print or Export dialog for details) or for copying to clipboard (see the Copy Image to 
Clipboard command). Note that the Dynamically Zoom menu item must not be checked for 
that purpose.



Printing

The SPLOT program enables to print the opened file using an installed Windows printer 
driver. Note that drivers for commonly used printers are supplied directly with your Windows 
package. Contact your printer vendor if you don't have a driver for your printer. Note that 
the printer term represents any output device (printer, plotter).

To start printing use the Print dialog which allows you to set final properties for a individual 
print job. You can set the other properties in the Print Setup dialog.



Exporting

The SPLOT program enables to export the opened file to the following formats:

HP-GL - Hewlett-Packard Graphics Language - the commonly used plotter format,
DXY-GL - the format specific to ROLAND DXY plotters,
DXF -    the AutoCAD's    drawing interchange file format.

The HP-GL format can be employed, for example, for plotting a picture cut on the    plotter, 
for the output of a multilingual text on the plotter (see the About Text Filter topic), or in case 
your plotter does not support all the HP-GL commands supported by the SPLOT program.    
The last case is characteristic especially of the situation you own the HP ColorPro 7440A    
plotter and you have not the additional graphics enhancement cartridge HP 17440A. Note 
that you can use a Windows HP-GL printer driver to produce a HP-GL output too (see the 
Printing topic), but this is usually slower method.

The DXY-GL format realizes the export of a picture to the DXY plotter (usually the ROLAND 
plotter).

The DXF format converts a picture to a form applicable by the AutoCAD program. From 
AutoCAD you can read this DXF file via the DXFIN command. The exported picture is written 
in the form    of LINES where each pen of the plotter has its own LAYER. Pen 1 has a layer 
with the name PEN1,    pen 2 has a layer with the name PEN2, etc.

To start and configure exporting use the Export dialog box.



About Text Filter

The SPLOT program is able to process a multilingual text in your HP-GL (or DXY-GL) files. As 
known, plotters receive only the ASCII characters in the range of 0 to 127.    Therefore, if the 
instruction for the output of the text (LB at HP-GL and P at DXY-GL resp.) contains the ASCII 
characters with the value higher than 127, the    plotter will not draw them or will ignore the 
highest bit of characters and will draw the corresponding characters from the lower half of 
the ASCII table. For example, if you use the following statement in GW-BASIC (handle #1 
represents the plotter),

PRINT #1, "LBGröße";CHR$(3)

the plotter will draw only the text

 Gre    or    Grae  respectively.

If you want to draw the text correctly, you have to use the following statements, e.g.:

PRINT #1, "CS0;CA33;SS;LBGr";CHR$(3)
PRINT #1, "SA;LB|~";CHR$(3)
PRINT #1, "SS;LBe;CHR$(3)

However, e.g., if you own the HP ColorPro 7440A plotter without an additional HP 17440A 
graphics cartridge, it will not help you either.

The above mentioned example concerns the use of a German text, but similar    problems 
occur also in other languages which use the ASCII characters from the upper half of the 
table.

Therefore, the SPLOT program offers the Text Filter function. You switch on    this function by 
checking the Text Filter item in the Options menu. Then all the ASCII characters from the 
value of 128 to 175 and ß character will be plotted according to the selected Code Page. 
And it does not matter what character set of the plotter is just set. This will enable to write 
multilingual texts in your HP-GL    (DXY-GL) files directly without complicated switching of 
character sets. The HP-GL (DXY-GL) file created in this way must be exported to a new HP-GL
(DXY-GL) form through the HP-GL    (DXY-GL) export with the Text Filter switched on, and only 
such a newly originated file can be drawn on the plotter. Or you can print the image directly 
to the plotter if you have an appropriate Windows plotter driver installed. (For details about 
exporting and printing see the Exporting and Printing topics or the Export and Print dialogs). 

To demonstrate using this method of writing multilingual texts we recommend you to study 
over the enclosed demonstration file ASCII.PLT and display it at first with the Text Filter being
switched off and then on.



Pen Identification

The identification of pens serves to emphasizing parts of the picture drawn with the same 
pen and to informing about the number of pens used during drawing the given picture. This 
information is useful namely for the correct loading of the plotter pens in case you decide to 
draw the given picture on the plotter.

The following conditions must be accomplished if you want to emphasize a part of the 
picture drawn with the same pen:

- the installed Windows video driver must support a logical palette with at least 16 items 
(usually a Super VGA video driver for a 256 colors mode),
- the Use Logical Palette item in the Options menu must be checked and must not be 
disabled (it is disabled if the preceded condition is not valid),
- the Pen Panel window must be opened (i.e., the Pen Panel item in the View menu must 
be checked).

Then if you click on the desired Pen Icon on the Pen Panel, a part of the picture drawn by the
corresponding pen will begin to flash and it will be flashing until you click another pen icon 
or if you do not cancel the identification by clicking the same pen icon. Note that a double-
click on a pen icon invokes the Pen Colors dialog for editing of the corresponding pen color.

The another purpose of the Pen Panel is to identify the numbers of    pens used during 
drawing the picture. At the beginning of drawing all the pen numbers are grayed, during 
drawing the number corresponding with the pen just being used is highlighted, after 
finishing drawing all the numbers corresponding with all the used pens are highlighted so 
that all the unused pen numbers remain grayed.



Configuration Files

The SPLOT program can save all the important options parameters (a palette of colors for 
pens, pen widths, etc.) in a SPLOT configuration file (named SPLOTW.CFG). The plotter 
device dependent parameters (e.g. paper size) can be saved to a plotter configuration file 
(named XXXXX.CFG, where XXXXX is the base name of the plotter DLL library; e.g. 
HP7475.CFG for the HP7475.DLL). If these configuration files are found, they are loaded on 
program startup. The SPLOT program first searches for these configuration files in the 
startup directory, then in the program directory.

The options parameters are saved automatically after program exit if the Auto Save Options 
switch in the Options menu is checked.

You can also use the Save Options Dialog in the Options menu to create the configuration 
files in any directory.

The existence of more configuration files in different directories if useful namely in the multi-
user environment.



Notes

When the SPLOT program is started, it is in the state corresponding with the state of the 
simulated plotter just switched on. When coming to plotting a new file, the program 
performs only the operation of changing paper. In this case the program (plotter) is in the 
state in which it has been left by the commands of the previous file. That is why it is 
generally recommended to place an initiating command sequence to the beginning of each 
file. It will bring the plotter to the well known state. Otherwise it can happen that the same 
file can be drawn in another way every time, dependently of    the contents of the previous 
plotted files. The author recommends to use the initiating sequence IN;RO;IP;IW; (in some 
plotters the IN command does not influence the setting of rotation).

In other cases the program is brought to the state corresponding with the switching off and 
on the plotter in these cases:

-    at change of plotter type,
-    at any change of the format or the paper size,
-    at any change of any parameter in the Plotter Specific Options... dialog



File Menu

The File menu includes commands that enable you to open and view a plotter file and to 
print or export the opened file.

Open...
Redraw
Start Demo/End Demo

Print...
Print Setup...
Export...

Exit



Open Dialog

This dialog serves for opening a desired plot file. Once a new file is opened the SPLOT 
program closes a previous plot file (if any) and begins drawing with new plot file. The opened
file is drawn until the end of file is reached or another new file is opened.

Click on an individual control to get more information about the Open dialog:



OK Dialog Button
Closes the dialog and initiates an associated action.    All made changes are accepted.



Cancel Dialog Button
Closes the dialog and no action is taken. All made changes are cancelled.



Help Dialog Button
Provides help information about this dialog (same as pressing F1 key).



File Name Text Box Control
You can type here a    file name, a filter, a drive, a directory or a complete path.



File Name List Box Control
This list box shows the existing files of the desired type in the current working directory. 
Selecting from the list replaces the contents of the text box.    Selecting via double-click 
causes plotting of the selected file.



Directory Tracking Text
This static text shows the complete path name of the current working directory.



Directories List Box

The directories list box displays:
- the parent directories, preceded by  icon,

- the current    directory,    preceded by  icon,
- the child directories of the current directory, preceded by  icon.

The directory icons and names are displayed according to their depth in the directory tree. 
To move to a directory, double-click the directory name or icon, or select it and then choose 
OK button (or press ENTER key).



Drives List Box

This drop-down list box displays the current drive letter followed by the volume name. The 
drive name is preceded by an appropriate drive icon:

    floppy disk drive,
    hard disk drive,
    RAM disk drive,
    network drive,
    CD-ROM drive.

You can select another drive as the current drive from this list.



File Type List Box

This drop-down list serves for selecting a desired type of files. Selecting a type modifies the 
contents of the files list box so that only files of the selected type are displayed.

These types of file are provided:
Plot Files Lists all files in the current directory    with a .PLT, .HPG and .HGL extensions.
All Files (*.*) Lists all files in the current directory.



Redraw Command

This command starts the redrawing of the opened plot file from its beginning.



Start Demo/End Demo Command

This command starts/ends a demonstrative drawing of all files with the .PLT extension in the 
current working directory.



Print Dialog

The Print dialog allows you to set final properties for a individual print job and start it.    You 
can set the other properties in the Print Setup... dialog.

Click on an individual control to get more information about the Print dialog:



Target Printer
This text informs you about the printer on which the printing will be performed.



Printed Area
This control determines which part of the drawing area will be printed:
Whole Image - the entire drawing area will be printed.
Viewed Window - only the intersection of the drawing and client areas will be printed (can 
be checked only when any dimension of the drawing area is larger than those of the client 
area).
Selected Area - the inverted area (area marked for zooming) will be printed.



Aspect Ratio
This control determines the aspect ratio of the printed image:
Proportional - the aspect ratio of the printed image will be identical to the original aspect 
ratio (based on the original plotter page, not on the screen view) of the selected printed 
area. This option is checked by default if the scaling is on. If the scaling is off, the maximum
possible area size of the printer page will be used. To do this proportionally one of the 
dimensions (X or Y) is usually reduced.
Fit to Page -    the printed image will be fitted to the entire area of the printer page. This 
can lead to the deformation of the image. This option can be checked only if the scaling is 
off.



Scaling
These controls serve for switching scaling on or off and for editing the scaling value. 
Switching the scaling on enables you to print in a desired scale;    e.g., if you set the scale 
factor to 100%,    the printed output will be in 1:1 scale to the original plotter size.
This assumes that the size of the printer page is large enough to hold the scaled image. 
Switching the scaling on automatically switches on the proportional aspect ratio of the 
printed image (see the Aspect Ratio controls).
If the scaling is switched off, the printed image will be fitted (proportionally or completely) 
to the maximum possible area size of the printer page.



Print Quality
The Print Quality drop-down list box allows you to choose from the list of printing resolutions 
provided by the printer device driver. This box may be disabled if you use an old version of 
the printer device driver. In this case use the Options button in the Print Setup dialog (note 
that old versions of printer device drivers can be set up globally only, i.e., they cannot be set
up for one program instance only).



Number of Copies
You can specify the desired number of print copies only if the printer device driver supports 
multiple copies. If the printer device driver does not support multiple copies, the number of 
copies is set to one and this edit control is disabled.



Print to File
If the Print to File check box is checked, a new dialog appears after you press OK and asks 
for the name of the file to which the print output should be sent. A file created in this way 
will print properly only on the printer for which it was generated - it is a device-dependent 
file, not a metafile.



Collate Copies
This option is meaningless in SPLOT program because of the print output is designated for 
one physical page only (this may be changed in future versions of SPLOT).



Print Setup Dialog

The Print Setup dialog allows you to set printing properties for a subsequent print jobs. 
These settings are valid only in the SPLOT instance in which they were made. At the start of 
the SPLOT program a system default printer and its settings are used.
Note that certain properties are set in the Print... dialog.

Click on an individual control to get more information about the Print Setup dialog:



Printer Selection
The Printer Selection controls allow you to choose a printer on which the plotted file will be 
printed.    The Default Printer button selects the printer established as the default by the 
system Printer Setup dialog (from Control Panel program). The Specific Printer button along 
with associated drop-down list box allow you to select another printer for a subsequent print 
jobs.    You can choose only from printers correctly installed in your system. At the start the 
SPLOT program selects a system default printer for a subsequent print jobs.



Orientation Selection
The Orientation Controls allow you to choose portrait or landscape printing. In portrait mode 
the tops of the graphics are parallel to the short edge of the page. In landscape mode they 
are parallel to the long edge.    If one of the modes is not available for the current printer and
paper type, the label and    button for that mode are dimmed, and the button for the 
available mode is selected.
Note that for older versions of printer device drivers this controls may be disabled. In this 
case use the Options button (note that old versions of printer device drivers can be set up 
globally only, i.e., they cannot be set up for one program instance only).



Paper Size and Source Selection
The Paper Size drop-down list allows you to choose from the list of paper sizes provided by 
the printer device driver. This list specifies the paper sizes that can be loaded into the 
printer, not the sizes that are actually loaded at the time of printing.
Note that for older versions of printer device drivers this controls may be disabled. In this 
case use the Options button (note that old versions of printer device drivers can be set up 
globally only, i.e., they cannot be set up for one program instance only).



Options Button
The Options button leads to a dialog that allows you to select additional driver-supplied 
printing options.    This button is disabled if no such options are provided.



Export Dialog

Use the Export dialog to start and configure exporting. See the Exporting topic for additional 
information.

Click on an individual control to get more information about the Export dialog:

HP-GL export dialog:

DXY-GL export dialog:



DXY export dialog:



Exported Format
The Exported Format drop-down list allows you to choose from the list of export formats 
provided by the SPLOT program:

HP-GL - Hewlett-Packard Graphics Language - the commonly used plotter format,
DXY-GL - the format specific to ROLAND DXY plotters,
DXF -    the AutoCAD's    drawing interchange file format.

For more information see the Exporting topic.



Output File
Type here the name of the file to which the export will be performed.



Output Size
You can select a predefined size or a user defined size. When you select the user defined 
size you must specify its X and Y dimensions.
The predefined output size Original is equal to the original plotter paper size (as specified in
the Paper Size dialog). If you use this size for exporting a non-zoomed image, you ensure the
1:1 scale for that export. Note that for the DXF export only user defined size is provided.
For all sizes you can specify an offset from the left margin (on the X axis) and from the 
bottom margin (on the Y axis).



Origin in Centre
Check this option only if the resultant HP-GL file is designated for the plotter in which the 
origin of the coordinate system is situated in the centre of the plotting area (it is usual with 
large paper size plotters, e.g. HP DraftPro or HP DraftMaster).



Resolution
This drop-down list box serves for selecting a plotter unit size for the DXY-GL format. It can 
be 0.1 or 0.025 mm. Note that for the HP-GL format the plotter unit size is always 0.025 mm.



Units
This drop-down list box serves for selecting a desired unit used for the output size 
measurement. It can be cm (centimetre) or inch. Note that the DXF format is an exception - 
here the output size is understood in units to be defined in AutoCAD.



Exported Area
This control determines which part of the drawing area will be exported:
Whole Image - the entire drawing area will be exported.
Viewed Window - only the intersection of the drawing and client areas will be exported 
(can be checked only when any dimension of the drawing area is larger than those of the 
client area).
Selected Area - the inverted area (area marked for zooming) will be exported.



Aspect Ratio
This control determines the aspect ratio of the exported image:
Proportional - the aspect ratio of the exported image will be identical to the original aspect
ratio (based on the original plotter page, not on the screen view) of the selected exported 
area.    To do this one of the dimensions (X or Y) is usually reduced.
Fit to Page -    the printed image will be exactly fitted to the selected output size. This can 
lead to the deformation of the image. 



Exit Command

This command exits the SPLOT program.



Options Menu

This menu provides access to the SPLOT options. All changed options can be saved in the 
SPLOT Configuration Files.

Plotter Type
Paper Size...
Pen Colors...
Pen Widths...
Plotter Specific Options...

Language
Text Filter
Code Page
Sound
Use Logical Palette

Proportional Aspect Ratio
Dynamically Resize
Dynamically Zoom

Minimize on Drawing
Active at End of Drawing

Save Options...
Auto Save Options

Copy Image to Clipboard



Plotter Type Menu

The Plotter Type menu serves for selecting a desired plotter type for simulation. You must 
have the corresponding DLL module:

Plotter type        Module name
HP 7470A HP7470.DLL
HP 7475A HP7475.DLL
HP ColorPro            HP7440.DLL
HP 7550A HP7550.DLL
HP DraftPro            HP7570.DLL
HP DraftMaster HP7595.DLL
ROLAND DXY    ROLDXY.DLL
ROLAND GRX    ROLGRX.DLL

An UNREGISTERED COPY of the program is available only in the version for the HP 7475A 
and HP DraftMaster plotters. The versions for other plotter types can be received only on the
basis of the regular registration. See the Licensing, registration and evaluation information.



Paper Size Dialog

This dialog serves for selecting one of the supported paper sizes of the just simulated Plotter
Type. Each paper size is given by a combination of the Paper Norm, Paper Format and 
optionally Expand modifier.    Note that the selected paper size is represented by the SPLOT 
drawing area (see the SPLOT Working Principles topic).

Click on an individual control to get more information about the Paper Size dialog:



Paper Norm
One of these paper norms can be selected for the desired paper size:

ISO - International Standards Organization's norm
ANSI - American National Standards Institute's norm
ARCH - architectural norm

Note that some plotter types do not support all the paper norms.    The unsupported paper 
norms are disabled.



Paper Format
According to the selected paper norm one of these paper formats can be selected for the 
desired paper size:

A4, A3, A2, A1 and A0 formats for the ISO norm,
A,    B,    C,    D and  E formats for the ANSI and ARCH norms.

Note that some plotter types do not support all the paper formats. The unsupported paper 
formats are disabled.



Paper Expand
The Paper Expand check-box switches on or off using of the expanded form of selected 
paper size. This option is disabled if the just simulated plotter type does not support it.



Pen Colors Dialog

Use the Pen Colors dialog to change the associated pen colors.

In SPLOT program each pen is associated with certain color.    These pen colors are used for 
screen drawing in color video modes and for printing on a color device.    For monochrome 
video modes all pens are displayed black and    the associated colors can take effect only for 
printing on a color device. In the same way on a monochrome printer all pens colors are 
black.

Click on an individual control to get more information about the Pen Colors dialog:



Pen Number
Use this radio button control to select a pen number its color you want to edit.



Actual Color
Shows the actual pen colors (before editing).



New Color
Shows the new pen colors.



Red Scroll
Use this scroll bar to set a value of the red color component.



Red Edit
Use this control to edit a value of the red color component    in range 0 to 255 inclusive.



Green Scroll
Use this scroll bar to set a value of the green color component.



Green Edit
Use this control to edit a value of the green color component    in range 0 to 255 inclusive.



Blue Scroll
Use this scroll bar to set a value of the blue color component.



Blue Edit
Use this control to edit a value of the blue color component    in range 0 to 255 inclusive.



Pen Sample
A screen sample of the just edited pen color.



Restore All
Restores all pen colors to their actual values.



Restore This
Restores just edited color to its actual value.



Pen Widths Dialog

The Pen Widths dialog enables you to manage a variable pen widths feature provided by the 
SPLOT program.

Click on an individual control to get more information about the Pen Widths dialog:



Pen Icon
A graphical representation of a pen.



PT Instruction
Check this radio button to set the PT Instruction pen width type to the corresponding pen. 
Then the line width of this pen will be determined by the PT    (pen thickness) instruction. The
line width is controlled by the HP-GL instructions and will vary according to value issued in 
the PT instruction. Note that each SP (select pen) instruction resets the pen thickness to its 
default value (mostly 0.3 mm).



Custom Width
Check this radio button to set the Custom Width pen width type to the corresponding pen. 
Then the line width of this pen will be determined by the user defined pen width value 
defined in the associated edit control.



Custom Width Edit
Define here a user defined pen width value for the corresponding pen. This pen width value 
is used only if the Custom Width option is checked for that pen. Note that the pen width is 
always expressed in millimeters (mm).



Restore
Use this button to restore the pen width options and value for an individual pen.



Use Pen Widths on Screen
Check this option if you want to use variable pen widths for screen drawing. 



Use Pen Widths on Printer
Check this option if you want to use variable pen widths for Printing. 



Zoom Pen Widths
Check this option if you want to enlarge the pen widths along with enlarging an image cut 
(see the Zooming topic).



Pen Widths on Printer
Select here a mode for use of the pen widths when printing. It can be:

Absolute - a real printed line width will be absolutely equal to the specified pen width.
Relative - a real printed line width will be computed from the specified pen width 
relatively to the original plotter page size (or its printed cut).

Only checking of the relative mode can ensure printing in the WYSIWYG style. However by 
checking the absolute mode along with PT width type for all pens you get a native plotter 
simulation.
Note that on screen the pen widths are always displayed in relative mode.



Restore All
Use this button to restore all the pen width options and values for all pens.



Set All Pen Widths Dialog

This dialog enables you to set a desired pen width type or user defined value to all pens.

Click on an individual control to get more information about the Set All Pen Widths dialog:



Select here a pen width type (PT Instruction or Custom Width) which you want to set to 
all pens. If you don't check any option, all the pen width types remain unchanged.



Set Custom Value
Check this option to define an user defined pen width value for all pens. Use the associated 
edit control to specify this value. If you don't check this option, all the user defined values 
remain unchanged even if you specify some value in the edit control.



Plotter Specific Options Dialog

Opens a dialog for setting of options specific to just simulated Plotter Type. This option is 
disabled if there are not specific options for this plotter type.



Language Menu

This menu serves for selecting a language in which the SPLOT program communicates with 
you. You must have the corresponding DLL module and help file for the desired language.



Text Filter Switch

This menu item switches on or off the use of the Text Filter functionality. 

See the About Text Filter topic for more information.



Code Page Menu

This menu serves for selecting the desired code page for the Text Filter function. At present 
these code pages are provided:

- United States
- German
- Portugal
- Canada - French
- Norway

Note that these are DOS code pages.

See the About Text Filter topic for more information.



Sound Switch

This menu item switches on or off the use of sounds for certain events (e.g., error,
end of drawing, etc.).



Use Logical Palette Switch

This menu item switches on or off the use of the logical palette of the just active video 
driver. This option is disabled if the video driver does not have a logical palette. Using the 
logical palette enables the full functionality of the Pen Identification. However using the 
logical palette may influence another application that uses logical palette when it is not on 
top.



Proportional Aspect Ratio Switch

If this menu item is checked, the aspect ratio of the drawing area is maintained to be 
identical to the aspect ratio of the selected paper size (see the Paper Size dialog). Otherwise 
there can be any aspect ratio of the drawing area which can lead to the deformation of the 
image.

For more information see the SPLOT Working Principles topic.



Dynamically Resize Switch

Check this menu item to automatically maintain the equality of the client and drawing areas.
If this menu item is not checked you can use the Resize menu command to cause this 
equality.

For more information see the SPLOT Working Principles topic.



Dynamically Zoom Switch

Check this menu item to start the zooming as soon as the zooming box is defined. If this 
menu item is not checked you must issue the Zoom command to start zooming.

For more information about zooming see the Zooming topic.



Minimize on Drawing Switch

Reduces the SPLOT program window to an icon whenever you start drawing (by opening a 
new file in the Open dialog or by issuing the Redraw command). Double-click the SPLOT icon 
placed on the desktop to switch back to the SPLOT program. 



Active at End of Drawing Switch

Activates and brings on top the SPLOT program window at each end of drawing.



Save Options Dialog

This dialog serves for saving of the options parameters to the configuration files to the 
desired directory.

Note: The options parameters are saved automatically after program exit if the Auto Save 
Options Switch is checked.



Auto Save Options Switch

Check this menu item to automatically save SPLOT option parameters to the disk 
configuration files when the SPLOT program terminates. The SPLOT program first attempts to
save these parameters to the original configuration files (i.e. configuration files from which 
the parameters are loaded). When this fails, it attempts to save these parameters to the 
startup directory.



Copy Image to Clipboard Command

This command copies part of the drawing area to the Windows clipboard in the bitmap 
format. The part to be copied is identical to the inverted area (i.e., area of the zooming box; 
see the Zooming topic for details). If there is not a zooming box defined, the entire drawing 
area will be copied into the clipboard.

The copied image can be pasted and used in a bitmap oriented program such as PaintBrush.



View Menu

This menu provides access to several Information Panels and to their arrangement:

Cursor Position
Pen Panel
Plotter State
Plotter Instructions

Arrange Panels
Auto Arrange
Auto Hide



Information Panels

These information panels are provided in the SPLOT program:

Cursor Position
Pen Panel
Plotter State
Plotter Instructions



Cursor Position Panel

The Cursor Position panel shows the mouse cursor coordinates in the drawing area 
expressed in plotter and user units. Note that the plotter and user coordinates do not differ if
the plotter scaling    (relevant to SC plotter instruction) is off.

Click on an individual control to get more information about the Cursor Position panel:



Plotter Units
This control shows the mouse cursor coordinates expressed in plotter units.



User Units
This control shows the mouse cursor coordinates expressed in user units.



Pen Panel

This panel serves via its Pen Icons for information about pens used during the drawing 
process (for more information see the Pen Identification and Pen Colors topics).



Pen Icon
A graphical representation of a pen. A single-click on the pen icon starts the Pen 
Identification of the corresponding pen. A double-click on the pen icon invokes the Pen 
Colors dialog for editing of the corresponding pen color. 



Plotter State Panel

The Plotter State panel shows the most important parameters describing the state of the 
plotter. For more information see the SPLOT Reference Guide supplied with a registered 
version.

A parameter control is grayed if it is in the off status or it is not supported by the just 
simulated plotter type.

Click on an individual control to get more information about the Plotter State panel:



Shows the just selected pen number.



Shows the current Up/Down and Absolute/Relative pen status.



Shows the current rotation status (0 or 90 degrees rotation).



Shows the current line type status (DF means default line type).



Shows the current velocity speed value.



Shows the label instruction activity and a just drawn character.



Shows the current label offset value.



Shows the current label terminator character.



Shows the current scaling points coordinates (always in plotter units).



Shows the scaling instruction status and its values.



Shows the current input window coordinates (in plotter units).



Shows the symbol mode instruction status and its character value.



Shows the use of the standard (SS) or alternate (SA) character set.



Shows the current value of the standard character set.



Shows the current value of the alternate character set.



Shows the current character slant value.



Shows the use of the absolute (SI) or relative (SR) character size and its values.



Shows the use of the absolute (DI) or relative (DR) character direction and its values.



Shows the current value of the pen thickness.



Shows the current values of the fill type setting (type,spacing,angle).



Plotter Instructions Panel

This information panel gives you the ability to trace individual commands of the opened file. 
The tracing is started by opening of this panel. You must close this panel to stop tracing.

Click on an individual control to get more information about the Plotter Instructions panel:



Instruction
This text control shows the just made plotter instruction.



Next Button
Press this button to perform and view the next instruction.



Auto Button
Press this button to start automatic (continuous) tracing.



Manual Button
Press this button to stop automatic tracing.



Redraw Button
Press this button to start redrawing of the opened file from its beginning.



Cancel Button
Press this button to close the Plotter Instruction panel and to stop tracing.



Arrange Panels Command

This command arranges position of all the Information Panels so that all these panels lie 
within the SPLOT client area.



Auto Arrange Switch

Checking this menu item causes the automatic rearrangement of all the Information Panels 
whenever the size or position of the SPLOT program window is changed or when a 
information panel window is opened or closed (see the Arrange Panels command).



Auto Hide Switch

Temporarily closes all the Information Panels whenever the SPLOT program loses input focus.
This option is useful namely if two or more SPLOT instances are opened to avoid confusion 
among panels.



Resize Command

Use this menu command to cause the equality of the client and drawing areas. This menu 
item is disabled if there is already this equality or if you have checked the Dynamically 
Resize item in the Options menu.

Note that using this command may change the size of the client area to ensure 
proportionality if you have checked the Proportional Aspect Ratio item in the Options menu.

For more information see the SPLOT Working Principles topic.



Zoom Command

This menu command starts the zooming. This menu item is disabled if no zooming box is 
defined.

For more information about zooming see the Zooming topic.



Expand Command

Use this menu command to expand a zoomed image into the original size.

For more information about zooming see the Zooming topic.



Help Menu

The help menu in SPLOT provides access to the Windows Help program and to an About box
which gives information about the program.



Keyboard Shortcuts

The following keys may be used in the SPLOT program:

F1 Help
F2 Open...
F3 Redraw
F4 Pen Colors...
F5 Paper Size...
F6 Pen Widths...
F8 Print...
F9 Open/Close the Plotter Instructions panel
Ctrl-C Open/Close the Cursor Position panel
Ctrl-P Open/Close the Pen Panel
Ctrl-S Open/Close the Plotter State panel
Tab Expand



Glossary



The command term.



The dialog term.



The switch term.



The menu term.



The panel term.



startup directory
The current working directory immediately after the program startup. You can set this 
directory in the Program Manager's Program Item Properties or on the SPLOT Command Line.



program directory
The directory in which the SPLOT executable and/or DLL files reside.




